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Assignment #10

Point Labeling with Description Keys

Recommend Assignments Prior to Working this Assignment:

Assignments 1-9

Required Assignments Prior to Working this Assienment:

None

Goals and Objectives

When AEC points are inserted into the drawing environment, they display the
point marker, number, elevation and raw description by default. The point settings can
be configured to show any combination of number, elevation and raw description or
configured not to show any of them at all. The “Point Settings” configuration only
affects points about to be inserted into a drawing environment. If it is desirable to change
the appearance of points already in the drawing environment without reinserting them,
then users must use the command “Points—=>Edit Points—=> Display Properties”.

Just as we labeled lines in previous lessons, points can also be labeled. One
advantage to using point labels as opposed to standard point markers (Marker, number,
elevation, Description) is that users can display more information with point labels than a
standard point marker. Point labels can be used to label points with any text string,
and/or a variety of other information such as Northings and Eastings which may be
extracted from the external COGO (Coordinate Geometry) points database. Point
labeling also gives users the flexibility of including a symbol in the form of a block with
their label.

One popular point labeling application occurs with tree labeling. A label style
can be set up so that points shot on trees only display a tree number, elevation and
symbol. Iftree points are inserted into the drawing environment using point labels in the
above referenced application, then the tree block comes in automatically along with the
tree number and elevation.
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The point label style shown above will generate a point label displaying the tree
number, elevation and COGO tree symbol t33 upon point(s) insertions into the drawing
environment. The symbol block path is specified on the “Insert” tab of the “Point
Settings” dialogue box. Point labeling must also be enabled on the “Insert” tab if it is
desired that Land Desktop label points.

Users might also choose to set up additional label styles for importing utility
points. As an example, a label style could be set up for inserting points and symbols
locating fire hydrants. In this case, a user may only want to display the fire hydrant and
spot elevation.

Although point labels in the above applications will save users time, it is not
desirable to set different label styles current as points are inserted to the drawing
environment by group or description. In the above referenced examples, users would
have needed to set each of the label styles current prior to bringing in points respective to
the point labels. The tree label style would have needed to be set current prior to
inserting tree points, just as the fire hydrant label style would have needed to be set
current prior to inserting fire hydrant points.

Before you set up point label styles for every manhole, mailbox, catch basin, tree,
sign and bush, there is another Land Desktop feature that enables users to automate
labeling to some degree. This feature is referred to as “Description Keys”. “Description
Keys” are used in conjunction with point labeling and are quite powerful. Whereas point
labeling allows users to label batches of points inserted to the drawing environment
having common parameters, the implementation of “Description Keys” permits users to
read in and label all points at once regardless of what they are. “Description Keys”
permit block symbol & layer mapping as well as scaling. Symbol blocks can be scaled
by parameters in the point descriptor. For instance, the descriptor “T O 7” can be read in
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and manipulated using “Description Keys” and point labeling to read “7 inch Oak” in the
drawing, be assigned a tree number, be mapped to a tree symbol and have the symbol
scaled by a factor of 7 upon its insertion into the drawing environment. In this example,
the layer containing the point marker could be placed on one layer, while the point label
be placed on a second layer and the block symbol placed on a third layer. In the above
referenced example, the description “T O 7” represents the “Raw Description” and “7
inch Oak” takes the place of the “Full Description”.

In this assignment, you will create a point label style for trees, and a point label
style for all other points to be inserted into the drawing environment. You will also
create a description key file to map descriptors with the label styles, layers, text and
symbol blocks.

Exercise Instructions

e [Logon to your workstation and begin a session of Land Desktop. If Land
Desktop has been configured on your workstation to display the “Start Up”
dialogue box, then cancel this feature so that the AutoCAD model space
environment is displayed. If launching Land Desktop brings you directly into
the AutoCAD model space environment, then Land Desktop has been
configured to begin without the startup dialogue. If the AutoCAD Map “Task
Pane” is shown, then close this dialogue box as well. Users that have the
ability to customize their profiles can turn these features off permanently by
following the procedure described in Assignment #1.

e Begin a new drawing by selecting “File->New”. Choose to create a new
project by picking the button labeled “Create Project”. Select the
“Prototype:” “Default (Feet)” from the drop down list. Give the project the
“Name:” “Assign10-##" where the “##” reflects the number which was
assigned to you on the first day of class. If the number assigned to you is a
single digit (for example 4 as opposed to 14), then enter a zero preceding the
single digit (such as 04). Write “Point Labeling with Description keys” in the
“Description:” and “Keywords:” areas. This will serve as a project summary
which may be used to find or filter projects using the Project Manager.

e Select “OK” to bring you back to the “New Drawing” dialogue box and type
the “Name:” “Assign10-##" where the “##” reflects the number which was
assigned to you on the first day of class. Make sure that the “Project Name:”
displays the correct project.

e Select the “Acad.dwt” template and then “OK” to generate a new drawing in
the “DWG” folder of the current project. After selecting the “OK” button,
you may be prompted to save changes to the previous drawing session. Since
there were no objects in the previous drawing session worth saving, choose
not to save changes.
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You will be prompted with the “Create Point Database” dialogue box. Accept
the default settings by choosing “OK”.

You will be prompted with the “Load Settings” dialogue box which displays a
list of drawing setups to choose from. These setups are saved back to the path
determined by the Network Administrator who installed the software. The
default path is to the local machine and is displayed in the dialogue box. We
will set up our parameters manually, so select “Next” to set up your project
with the following parameters:

Units Area
Linear Units = Feet
Angle Units = Degrees
Angle Display Style = Bearings
Display Precision Linear = 2
Display Precision Elevation =2
Display Precision Coordinate = 5
Display Precision Angular = 4
“Next”

Scale Area
Horizontal = 60
Vertical = 1
Paper Size =8 x 11(A)
“Next”

Zone Area
“Next”

Orientation Area
[3 CNeXt’ 9

Text Style Area
Leroy.stp
L80

Then select “Finish” and a screen will display providing the user with a
summary of the settings chosen. Review the settings and select “OK”.
Although users have the ability to save settings for retrieval with future
projects, assignments in this text require that you set up the parameters
manually for practice in each project.
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Create several new layers with the following parameters:

Layer Color Linetype

C-ANNO-VPRT white continuous
C-PNTS-TREE Red continuous
C-PNTS-UTIL Green continuous
C-TREE-EXST Green continuous
C-UTIL-SYMB Cyan continuous

Set your point settings (Refer to Assignment 3 if you can't remember how this
was accomplished) so that your point text comes in with the L.80 text style.
Using the “+” marker, your marker height should be set at '% the model space
text height. The corresponding marker height for a text height of 4.8 units is
2.4. Set a text rotation angle of 30 degrees.

Set your point settings to allow the use of point labels by selecting
“Points—=>Point Settings—> Insert (Tab) ” and turning on the checkbox to “Use
Current Point Label Style When Inserting Points”. The “Search Path for
Symbol Block Drawing Files” is the path that Land Desktop uses to find
blocks which are inserted with point labeling. Change the path to reflect the
COGO folder for the Land Desktop 2006 symbol manager folder. Although
the location of this folder can be altered with the software installation the
default installation path is:

“c:\documents and settings\all users\application data\autodesk\autodesk land
desktop 2006\r16.2\data\symbol manager\cogo\”

Refer to the graphic below for reference.

ﬂ
Create  Insert |U|:-date| Ccu:rdsl Description Keysl Markerl Text | Preferences

These settings control the inzertion of points in the AutoCAD drawing.

—Search Path for Syrbal Block Drawing Files

Ic:\documents and settingshall usershapplication data%aut Browse... |

r Inzertion Elewation

" Actual Elevation If No Elevation Usze: 0.00
% Fired Elevation Fixed Elewvation: 0.0o0
— Point Labeling

[v' ilize Current Point Label Style ‘when [nzerting Paoints

Current Point Label Style:

active desckeys only

0K I Cancel Help
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e Launch the description key manager through the menu “Points—>Point
Management—> Description Key Manager”. After the dialogue box opens,
select “Manager—>Create Desckey File” and give it the file name “Assign10”.

Right select on the newly created description key file and select “Create
Desckey”. Proceed to fill out information as shown in the dialogue box
below. In the “Desckey Code” area type “t*”. Fill in areas as shown below for
three different Description keys. Keep in mind that description keys are case

sensitive.

14 - Description Key Properties

Dezckey Code: It"

General | Scale/Fotate Symboll

Drescription Format;

Paint Layer:

|0AK TREE

|C-PNTS-TREE

Syumbol Inzertion

Symbal Block Mame:

Symbal Layer:

Preview

I cg_t33

|C-TREEEXST

Xl
Cancel |
Help |

14 - Description Key Properties

Dezckey Code: It"

General  Scale/Raotate Spmbol |

— Scale Symbol By:

—Apply Scale To:

$ m ¥ % Dimengions
I¥ Fixed Seale Factor |1|:|— [ Z Dimension
[ Cument Dwg Scale; 1"'=60.0°
— Ratate Syrnbal B r— Direction:
[ Description Parameter k3 m % Llockwize
[ Fired Rotation ID— ' Courter-Clockuwize

Xl
Ok |
Cancel |
Help |
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5I
Dezckey Code: Ifh
General | Scale/Raotate S_l,lmboll ﬂl
- Help |
Dezcription Farmat: IFIHE HYDRAMT

Point Layer: |C-PHTSUTIL
Symbal |nsertion Prewigw
Sernbal Black Manie: Ie_h_l,Jd j
Symbal Layer: IC-UTIL-SYME

14 - Description Key Properties ﬂ

Dezckey Code: Ifh ak. |
General  Scale/Raotate Spmbol | Cancel |
—Secale Symbol By: Apply Scale To: —IH elp

V¥ % Dimensions

™ Fixed Rotation ! Counter-Clockwise

$ |1 3:
[ Fixed Scale Factor |1 ™ Z Dimension
¥ Cument Diwg Scale; 1"'=60.0°
— Hotate Symbaol By: r— Direction:
[ Description Parameter k3 I'I 3: % Llockwize
ID

x
Desckey Code: Iip
General | Scale/Faotate S_l,lmboll ﬂl
L Help |
Drescription Format; IJDINT FOLE

Paint Layer: JCPNTS-UTIL
Syumbol Inzertion Prewiew
Spmbaol Block Mame: Iu_pu:nle ﬂ
Symbal Layer: IC-UTIL-SYMB
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x
Desckey Code: Iip 0K |
General  Scale/Rotate Spmbol | Cancel |
— Scale Symbol By —hpply Scale T, ———————— Help |

V¥ % Dimensions

% I'I 3:
™ Fixed Scale Factor |1 [ Z Dimension
¥ Curent Dwa Scale; 1'=60.0
— Rotate Symbol By: — Direction:;
[ Description Parameter $ |1 3: % Clochwise
II:I

[ Fixed Fotation ! Counter-Clockize

e The “Description Parameter”, “2”, found on the “Scale/Rotate Symbol”, tab
instructs Land Desktop to read the second parameter past the base descriptor
for scaling the associated block. In the description “Tree O 77, the base
descriptor is “Tree”. The first parameter is “O” for Oak tree. The second
parameter is the number “7”. The $2 instructs Land Desktop to scale the
symbol by a factor of 7.

e When you are finished entering description key information, the dialogue box
should look something like the one below.

+- Description Key Manager ;Iglll

Manager Help

B #& B

5= @ Assignl0 Code | Farmat | Paint Layer | Swrnbol Block M. .. | Swmbal La. . |
""" DEFALLT fh FIRE HYDRAN C-PHTS-UTIL e hyd C-UITIL-SYME
ip JOINT POLE  C-PNTS-UTIL  u_pole C-UTIL-SYME
P OAK TREE  C-PNTS-TREE cg_t33 C-TREE-EXST

e Exit the description key manager and select “Labels—>Edit Label
Styles>Point Label Styles” to create two new point label styles as shown
below named “Elevation, Block™ and “Point, Elevation, Block™.
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Edit Label Styles x|
Line Label St_l,llesl Curve Label Stylesl Spiral Label Styles  Point Label Styles I
— Tenut P! tie
Marne: IEIevation, Black. j Heﬁ htroper m I —
eight: . =
Data: Point Humber ﬂ CC On
Blevat_iotrj Offzet: |1 CRE O
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 Text Units
{Elevation} =1 [1o0.00 Lingar... |
1 » | Angular... |
— Carmmon Symbal — Description Key
™ Insert Commaon Symbal ¥ Desckey Matching On
Black: Ibus j Desch.ep File: Azxzignl0 j
Lewsr IDD NOT LISE THIS AHEAj ¥ Substitute Desckey Description
¥ Insert Desckey Symbol
Save | Delete I
Ok I Cancel Help |
Edit Label Styles x|
Line Label St_l,llesl Curve Label Stylesl Spiral Label Styles  Point Label Styles I
— Tenut P! tie
Marne: IPoinl, Elewation, Black j Heﬁ htroper m I —
eight: . =
Data: Point Humber ﬂ CC On
Blevat_iotn Offzet: |1 CHE O
Nsrstﬂifqmn hd O Elevation
KDRek: I 'I »r Text | Shyle: I"Eunent" j
Iv Tumn O Marker Test Layer: I"Cunent" j
 Text Units
TREE Mo {Paint Mumber} =1 |TREE Mo 100,00 Linear... |
{Elevvation} = 100.00
1 » Angular... |
— Common Symbol — Description Key:
™ Insert Commaon Symbal ¥ Desckey Matching On
Black: Ibus j Desch.ep File: Azxzignl0 j
Lewsr IDD NOT LUSE THIS AHEAj ¥ Substitute Desckey Description
¥ Insert Desckey Symbol
Save | Delete I
k. I Cancel | Help |

“DescKey Matching On” must be checked to allow the point label style to
obtain information from the description key file. Specify the “Desckey File: ” which

you just created for this assignment.
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A “Common Symbol” is not required, because the symbol will be inserted to

the CAD environment using the Description Key file. In order to accomplish this,
make sure the check box “Substitute DescKey Symbol” is checked.

The “Substitute DescKey Description” checkbox instructs Land Desktop to

alter the Point(s) full description to take on the description specified in the
“Description Format” area for each Description Key in the Description Key Manager.

Select “Labels—> Settings—=>Point Labels” and set the “Elevation, Block” label
style which you just created current. Specify a rotation angle of 30 degrees.

Set the “C-PNTS-UTIL” layer current and select “Points—> Import/Export
Points—>Import Points” to read in your project points which correspond to this
lesson using the “PNEZD” comma delimited format. Lesson files may be
downloaded from www.schroffl.com. As you read these points in, add them
to a new point group named “All_Points”. Choose to overwrite points when
prompted with the “Cogo Database Import Options”. Zoom extents, and you
should see spot elevations and symbols in the drawing environment.

In “Labels—> Settings—=>Point Labels” set the “Point, Elevation, Block™ label
style current. While on the “C-PNTS-TREE” layer, insert only points having
the description tree. Refer to Assignments 4 & 5 if you can't remember how
this is done. Choose to replace all points when prompted. The tree spot
elevations are now on their respective layer. Tree symbols have been inserted
into the drawing environment and scaled.

Pick the layout tab currently titled “Layout]” so that this layout becomes
active. Right click on this tab and choose to rename the layout tab to “Plat”.
Now that you are in paperspace, change to the layer “C-ANNO-VPRT” and
create a landscape viewport 11'x8.5" at a 60 scale for the map.

Save and exit this drawing. You have successfully completed this assignment.

10.10



Point Labeling with Description Keys
o
3
?g/
o
T
<50 N
* @59 100
B pos
N N
WO WO
< 2
0 o
&° o
)
N
¢ «i%%@
NS
\6 A\
\o <&
. WP
% & °
e )
N
xﬁg@
® Q© ®
- o o 2
° ©° @’ 3 o
p:oy

POINT LABELS HAVE BEEN MOVED SLIGHTLY TO MAKE THEM
MOVING POINT LABELS TO MAKE THEM
READABLE IS NOT REQUIRED FOR THIS ASSIGNMENT.

MORE READABLE.

Reference Figure: Assignment 10
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NOTES:
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